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Introduction 

You can use the Xythos Drive to connect, or map, a network drive to a folder on a 
WebDAV server, effectively turning the Internet into a secure, shared virtual hard 
drive. The Xythos network drive behaves exactly like a Windows network drive, 
except that it uses HTTP and WebDAV* protocols. This permits any Windows program 
to open and edit documents stored on a web server as easily as if they were on your 
computer. 
 

This manual provides help on the various features available within the Xythos Drive.  

The Quick Start chapters 3-9 provide step-by-step instructions on commonly used 
features.  

The Personalizing chapters 10-16 help you to fine tune Xythos Drive to meet your 
needs in working with My Webspace. These chapters describe the features and 
options in detail. The pages are arranged to correspond to the tabs in the user 
interface to make it easy to find what you are looking for.  

We hope that you find the answers to your questions within these pages. If you care 
to leave us feedback and suggestions for how we can improve these pages, please 
send it to mywebspace-admin@lists.wisc.edu.  

  

  

*WebDAV stands for "Web-based Distributed Authoring and Versioning". 
It is a set of extensions to the Hypertext Transfer Protocol (HTTP) 
standard. HTTP is the set of rules for reading and viewing text, graphic 
images, sound, video, and other multimedia files over the Internet. 
WebDAV adds rules for creating, changing, and moving documents, 
provide functionality to build web-based file storage that can be 
accessed from anywhere. 

WebDAV also adds features that make possible collaborative editing 
and file management between users located remotely from each other 
on the Internet, including:  
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 Edit a document  

 Add and remove people from the list of collaborators  

 Grant read, write or sharing permissions for each user  

 Lock the document to protect your changes from being 
overwritten  

 Check-out, check-in, and retrieve previous versions  

With WebDAV, a dispersed team connected by the Internet can safely 
and securely work together.   
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Terms of Service 
(Appropriate Use 
Guidelines) 

We are excited to be able to offer you this service, and hope that you will find it 
beneficial for you in your studies and employment. As you log in for the first time, 
we want you to be aware of some of the rules of the road for usage. In addition to 
the terms for computer usage that you agreed to when you activated your NetID, 
there are some additional rules specific to usage within My WebSpace.  

By logging in and using My WebSpace, you are agreeing to adhere to the following 
terms of service: 
 
I. Appropriate Use 
 
Individuals using this service are required to: 

• Follow the “Guidelines for Appropriate Use of University of Wisconsin-
Madison Information Technology Resources”, located at 
http://www.doit.wisc.edu/security/policies/appropriate_use.asp.  

• Protect the privacy and confidentiality of student, patient, employee 
and other institutional information, as required for example by FERPA 
(privacy of student information) described at 
http://registrar.wisc.edu/ferpa/, and HIPAA (privacy of patient 
information) described at http://www.wisc.edu/hipaa/.  

• Comply with all other applicable University policies, State and Federal 
laws, including for example: copyright law, described at 
http://www.copyright.gov/help/faq/ and the student code of conduct, 
located at http://www.wisc.edu/students/misconduct.htm.  

II. System Use 
 
My WebSpace is available only to UW-Madison students, faculty and staff with an 
active NetID. 
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• You are responsible for the integrity of your data files.  

• We recommend that you keep backup copies of your critical files on 
other media, such as a local hard drive, CD-ROM, and/or zip disks. In the 
unlikely event that there is a system outage, your online files will not be 
accessible until service returns.  

• Before you leave the University, be sure to download copies of your data 
to other media, such as a local hard drive, CD-ROM, and/or zip disks.  

• My WebSpace administrators will verify your eligibility after each fall 
and spring semester begins. If you are no longer eligible for My 
WebSpace at those times, you will be notified and your files will be 
deleted.  

• My WebSpace allows for 1GB of disk space for storage and 400MB/hour 
for uploading and downloading of files.  

III. Privacy Statement 
 
UW-Madison respects the legitimate privacy interests of My WebSpace Users within 
appropriate limits for educational, ethical and legal reasons. 

• My WebSpace administrators routinely monitor the volume of My 
WebSpace traffic for system management purposes.  

• Usage may also be subject to security testing and monitoring.  

• If the University receives a credible report that a violation has occurred, 
or if, in the course of managing the service, discovers evidence of a 
violation, then the matter will be referred for investigation, University 
disciplinary action, and/or criminal prosecution.  

• Complaints that specific material violates the law or University policy 
should be reported to Badger Incident Response Team (BadgIRT), as 
described at: 
https://www.doit.wisc.edu/security/report_incident/index.asp.  

• If you are employed by the University, you should be aware that any 
documents that you save or publish in My WebSpace may be subject to 
the Wisconsin Open Records Act. For more information on the Records 
Management, please go to: 
http://archives.library.wisc.edu/rm/manual/ManualLegal_ch6_.html 
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Prerequisites 

The Xythos Drive is a desktop application that must be installed on each computer 
where it will be used. To install the Xythos Drive, the user must have Administrator 
rights on the computer. Once the Xythos Drive has been installed, the user does not 
need Administrator rights to use the software.  

 
Requirements for the Xythos Drive:  

 Operating Systems:  

 Windows 2000  

 Windows XP Home  

 Windows XP Professional  

 Windows Vista  

 Hard disk space (calculate by adding up the following three items):  

 10MB for base install  

 Total size of all files you will require to be available offline  

 2 * the size of all files you will be actively working with  

 Internet connection  

Running with a Virus Scanner 

If you are running a real-time virus scanner, it is recommended that you configure 
the virus scanner to exclude scanning of the Xythos Drive cache. Doing this provides 
a noticeable performance improvement when working with the cache, such as during 
opening and editing of files. Excluding the cache from the virus scanner does not 
compromise the security of the system. The cache is located in the folder 
C:\Documents and Settings\<user>\Local Settings\Application Data\Xythos\cache, or 
if you are using Vista, C:\Users\<user>\AppData\Local\Xythos\cache.  

Refer to your virus scanner’s instructions to learn how to exclude specific directories 
from being scanned. 
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Uninstalling Xythos Drive 

The Xythos Drive can be uninstalled in a couple of ways.  

To uninstall Xythos Drive from the Control Panel:  

1. Open the Windows Control Panel.  

2. Select Add/Remove Programs. 

3. Scroll down and select Xythos Drive. 

4. Click Change/Remove. 

5. Follow uninstall wizard instructions. 

6. When uninstall is complete reboot your computer. 

To uninstall Xythos Drive from the Windows Programs menu: 

1. In the taskbar, click Start, select Programs, and then select Xythos Drive. 

2. Select Uninstall Xythos Drive. 

3. Follow uninstall wizard instructions. 

4. When uninstall is complete reboot your computer. 
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Working Online 

To access server-based files you must first establish a connection with the server. To 
make the connection, the Xythos Drive needs information, such as the server 
address, the folder to connect to, your identification, etc. This information is saved 
in a service.  

For help creating and configuring a connection to the My WebSpace service, please 
refer to the Connecingt to My WebSpace chapter on page 25. It is also possible that 
your administrator has already pre-configured a service for you to use. In this case, 
you can simply proceed to the next step.  

Connecting to a server 

1. To display the Xythos Drive window, in the Windows system tray, click the 
Xythos Drive icon  .  

2. On the Xythos Drive window, click the Connect tab.  

3. Right of the Service box, click the Service Name arrow to view the available 
services, and then choose the name of the service that you want to use.  

4. In the Drive box, select the drive letter you want the service to be mapped 
to, if you do not want to use the default.  

5. Click Work Online.  

6. Enter your Username and Password, if necessary.  

In Windows Explorer you will now see a drive letter mapped to the folder specified 
in the service you selected. You can access the contents of that folder in the same 
manner you use files and folders located on your local hard drive. 

If you have trouble connecting... 
If you are having difficulty connecting to the server you should do the following 
things:  
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 Verify the computer has an established Internet connection. A good test is to 
use a web browser to access the server. If the web browser can not access 
the server, then it may be a networking issue.  

 If you must use a proxy to access the server, then make sure you have 
correctly configured it on the Advanced tab. Please see the Chapter 16 for 
more information on the configuration options. 

 Make sure all the service settings are correct. On the Connect tab, click the 
Service arrow, and then click Edit to view the service properties.  Verify the 
server URL. Click the (...) button to the right of the Server URL box to view 
and verify the Use secure connection setting.  

For more information about creating services refer to the Connecting to My 
WebSpace chapter page 25. 
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Working Offline 

Using your Xythos Drive to turn the Internet into a virtual hard drive offers many 
advantages.  However, an Internet connection may not always be available. With 
Xythos Drive you can access recently used files or files you have selected to always 
be available offline, even when the Internet is not available.  

Connect to the server in offline mode 

1. On the Connect tab, click the Disconnect if necessary. You need to 
disconnect before you can work offline.  

2. In the Drive box, choose a drive letter or use the default, and then click 
Work Offline.  

3. If you see a dialog box, type your username and password, and then click 
OK.  

Making files and folders available offline 

Any files that have been opened recently will be available when you are offline as 
long as the local cache has not been cleared. To make sure that important files are 
always available offline, they should be marked as such. You must be connected to 
the service to select files and folders to be available offline.  
 
Use Windows Explorer to select files and folders to access offline: 

1. Using Windows Explorer, right-click to select a file or folder to make it 
available offline, and then select Always Available Offline.  

2. If you select a folder:  

a. On the Confirm Offline Subfolders dialog box, select No to make 
only the files in the selected folder always available offline, or 
select Yes to also make all subfolders and their contents also 
available offline.  

b. New Folders created in a folder that has been marked as always 
available offline will automatically be available offline.  
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Files selected for offline availability are copied to your local hard disk, increasing 
local disk usage and possibly slowing folder listings and synchronization. 

Displaying offline file status 

This feature is not available on Microsoft® Windows Vista™. 

You can configure Windows Explorer to display whether a file on your Xythos WebFile 
server is selected for offline availability. 

1. Explore the mapped drive with Windows Explorer.  

2. On the Windows Explorer View menu, select Choose Details. Alternatively, 
in the Windows Explorer window, right-click any column name, and then 
select More.  

3. Select the Xythos Drive Status check box.   

4. Click OK to return to Windows Explorer.  

Files that have been selected to always be available offline have Present offline in 
the Xythos Drive Status column.  

Working with offline files 

1. Make sure all files from your mapped are closed.  

2. To display the Xythos Drive window, click the Xythos Drive icon in the 
Windows system tray.  

3. On the Xythos Drive window, click the Connect tab.  

4. Click the box containing service names Service Name to view the available 
services, and then choose the name of the service that you want to use.  

5. If the status is Working Online, then click Disconnect.  

6. Click Work Offline.  

When your folders and files are available for access offline, a red X appears over the 
drive when you open My Computer or Windows Explorer. As you browse your files you 
will notice that the files and folders that are not available while you are working 
offline appear dimmed.  

 Synchronizing offline files 

After you have been working offline for a while, it is likely that you will need to 
synchronize your work with the server. Xythos Drive is set up to automatically 
synchronize with the server changes made while working offline the next time you 
connect to the server. If you uncheck this option, your files will not synchronize. 
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If a file you have edited has been updated on the server since you last synchronized, 
possibly by another user, you will get prompted with a dialog asking you what action 
to take. You can either choose to overwrite the other user's edits, to save your 
changes to another location, or to discard your edits.  
 
To manually synchronize your files, on the Xythos Drive Offline tab, click 
Synchronize Now. The local cache will be updated with the latest copies from the 
server. The server will not be updated with the latest copies from the cache. To 
synchronize from the desktop to the server, you must choose one of the automatic 
synchronize options. 
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Using Windows Explorer 
Xythos Drive is primarily used with Windows Explorer, allowing you to work with files 
and folders in your account the same way you work with files and folders that are on 
a local drive. Standard drag and drop operations are supported by Xythos Drive. In 
addition, there are several other features that you can use when working within 
Windows Explorer.  

Creating an Intellittachment 

1. Right-click either a server-based or local file, you see a menu selection, 
Create Intellittach.  

2. In the Intellittach dialog box, choose to send the file as link (read access 
permissions are required to view) or a ticket (no access permission 
required). An email message with the file's URL in the message body is 
created.  

3. Complete the message, and then click Send. The next time you run your 
email program, the message is sent.  

Recipients see an attachment and a link in the message body, and can access the file 
using either one. If you sent a link, they will be asked to login to access the link, or 
the attachment. 
 
For more information on using Intellitach, please see Chapter 12.  

Copying URL to Clipboard 

When you right-click a file or a folder, you will see a menu selection, Copy URL to 
Clipboard. This command copies the full My WebSpace URL to your clipboard. You 
can then paste this URL into an email message, an instant messaging session or into 
another document.  
 
When you use this feature, recipients with read or write permissions directly access 
the file. They have access to your latest changes, and if they have write access, can 
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make changes to the original file. When used with versioning and locking, this is an 
effective way to collaborate. 

Setting up Subscriptions 

Subscriptions are email notifications that your receive letting you know when 
someone has accessed a file or folder. You may create a subscription for any file or 
folder in your account.  To setup a subscription: 

1. In Windows Explorer, locate the file or folder.  

2. Right click the file or folder, and then select Subscriptions.  

3. A browser window will open and you will be asked to log in to your My 
WebSpace account.  

4. Click the Create Subscription button in the top toolbar.  

5. Fill in the required information:  

a. Select the events you want to initiate an email notification.  

b. Select when you want the notification sent. You can choose to have 
the notification sent immediately when the action takes place or as 
part of a report that is sent on a daily basis.   

6. Click Ok.  

7. Close the browser.  

Starting and Stopping Access Logging 

Logging allows you to keep a record of who accesses your files and when they do so. 
You can start and stop logging, and you can view the history of who has accessed the 
file while logging was enabled. 

To enable Access Logging on a file: 

1. In Windows Explorer, locate the file.  

2. Right click the file, and then select File Access Log.  

3. A browser window will open and you will be asked to log in to your My 
WebSpace account. 

4. To start logging, in the browser window that opens, 

5. To start logging, click the Enable Access Logging button in the top toolbar.  

6. To stop logging, click the Disable Access Logging button in the top toolbar.  

7. To view the log, click the Refresh Log button in the top toolbar.  
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8. When you are finished, close the browser.  

 

To enable Default Access Logging on a folder: 

1. In Windows Explorer, locate the folder.  

2. Right click the file, and then select Manage.  

3. A browser window will open and you will be asked to log in to your My 
WebSpace account. 

4. Click on the Default Logging link. 

5. In the drop down menu, select On. 

6. If you would like this setting to apply to all files and folders that are 
currently in this folder to have logging On, check the box. 

7. Click “Apply Now” 

8. When you are finished, close the browser.  

 

Displaying Xythos Drive Status column 

This feature is not available on Microsoft® Windows Vista™. 

You can view additional information on the files and folders contained within a 
Xythos Drive mapped drive in Windows Explorer. This information includes locks and 
offline availability. To view this information in the Explorer window, you must 
enable the Xythos Drive Status column. To do this:  

1. In Windows Explorer, select the drive that corresponds to the service.  

2. On the View menu, click Choose Details.  

3. In the displayed window, select the Xythos Drive Status check box.  

4. Click OK.  

5. To display the Xythos Drive Status for all folders on your computer, on the 
Tools menu, select Folder Options.  

6. Click the View tab.  

7. Click Apply to All Folders.  

8. Click OK.  

 14 



M Y  W E B S P A C E  X Y T H O S  C L I E N T   
U S E R  M A N U A L  
 
 

When a file is locked, this column will also display Locked by user name. Files that 
have been selected to always be available offline have Present offline in the Xythos 
Drive Status column.  

Displaying the Display Name column 

This feature is not available on Microsoft® Windows Vista™. 

You must be connected online in order to use this feature. 

Displayname is a standard WebDAV property. It is intended to be used by servers 
that generate file names as user-friendly identification. On a Xythos server, where 
file names are defined by the user, the displayname is the same as the user given 
file name.  

You can view the displayname property for files and folders in a separate column in 
Windows Explorer. This is very helpful if the server uses the displayname property to 
identify the file. To do this:  

1. In Windows Explorer, select the drive that corresponds to the service.  

2. On the View menu, click Choose Details.  

3. Scroll the window and select the Display Name check box.  

4. Click OK.  

5. To display the Display Name column for all folders on your computer system, 
on the Tools menu, select Folder Options.  

6. Click the View tab.  

7. Click Apply to All Folders.  

8. Click OK.  

The Xythos Drive still uses the standard name for all of its operations, not the 
displayname.  

Adding and Deleting Custom Properties 

You must be connected online in order to use this feature. 

You can create custom properties for files.  

1. Using Windows Explorer, locate the file.  

2. Right-click the file or folder, and then select Properties.  

3. In the displayed window, select the Xythos Drive tab.  

4. In the Name box, type the property name.  

5. In the Value box, type a property value.  
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6. Click Add Property. The new property and value are displayed in the 
Properties box.  

7. To save the new property, click Close or Apply.  

To delete a custom property: 

1. In the Properties box, select a property.  

2. To select multiple properties, press the CRTL key as you select each one.  

3. Click Delete Property, and then click Close or Apply.  

Although displayname is listed in the Properties box, you can not delete it. 

Modifying Custom Properties 

You must be connected online in order to use this feature. 

You can create, view, edit and delete custom properties for files. To work with the 
WebDAV properties for a file:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file or folder, and then select Properties.  

3. In the displayed window, select the Xythos Drive tab.  

4. In the Name box, type the property name of the property you want to 
change.  

5. In the Value box, type the new property value.  

6. Click Modify Property. The property and new value are displayed in the 
Properties box.  

7. To save the new property, click Apply then Close. 
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Sharing Files and Folders 

You can use the Xythos Drive to view, add and remove permissions from your files 
and folders. The permissions are controlled and maintained by the server. You can 
share your files with individual users or groups of users by giving them one or more 
of permissions: 

Read Permission 
Read permission allows other users or groups of users to view your file or folder. If a 
user has read permission on a folder but does not have read permission on all of the 
contents of that folder, the user will see only the file and folders in which the user 
has read permission.   
 
Write Permission 
Write permission allows other users or groups of users to edit the file or folder. 
Write permits the editing and viewing of the properties and contents of that item, as 
well as renaming the item, if the user also has delete permission on the item.  
 
Delete Permission  
Delete permission allows other users or groups of users to move the file or folder to 
the Trash.  
 
Administer Permission 
Administer permission allows other users or groups of users to change permissions of 
the file or folder.  

Viewing permissions 

To view the permissions that exist on a file or folder:  

1. Using Windows Explorer, locate the file or folder.  

2. Right-click the file or folder, and then click Sharing.  

 17 
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The Share with users box lists all of the users with permission to access the 
file or folder.  Depending on the way your server is set up, certain users or 
groups, below, may appear in the list: 
 
Owner 
This is the user that owns a file or folder. 
 
Authenticated Users 
These are any other users within the same Xythos system as you. Use this 
category to share your file and folder with all users of your Xythos system. 
 
Public 
Any user accessing the Xythos system without an account. Use this category 
for making your files and folders public to the outside world. 
 
Other users that have been given privileges will also be listed.  

3. Under Share with users, select a user or group to display in the Permissions 
box, all permissions for that user will be marked.  

Removing permissions 

To remove a user's or group's permissions for a file or folder:  

1. Using Windows Explorer, locate the file or folder.  

2. Right-click the file or folder, and then click Sharing.  

3. Share with users lists all of the users with permission to access the file or 
folder. Select the user or group whose permissions you would like to remove, 
and then click Remove.  

4. To save these changes, click Apply, then click OK.  

Changing permissions 

To change a user's or group's permissions for a file or folder:  

1. Using Windows Explorer, locate the file or folder.  

2. Right-click the file or folder, and then click Sharing.  

3. Share with users lists all of the users with permission to access the file or 
folder. Select the user or group whose permissions you would like to change.  

4. In the Permissions box, select or clear the appropriate check boxes.  

5. To save these changes, click Apply, then click OK.  
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Adding Permissions 

This feature is not currently available on Microsoft® Windows Vista™. 

To add a user or group to a Permissions list:  

1. Using Windows Explorer, locate the file or folder.  

2. Right-click the file or folder, and then click Sharing. The Sharing Options 
dialog box lists the users that have permission to access the file.  

3. To share the file or folder with a user or group not listed, click Add.  

4. In the Search for box, type * to list all names, type a partial name to lookup 
all users and groups whose name includes the partial name.  

5. In the IN box, select either the Display Name or the user ID. Display Name, 
like the displayname property, is a user-friendly name. If you select ID, 
Xythos on Demand usernames are searched.  

6. To get as list of all users and groups with partial name in their name, click 
Search.  

7. Select one or more of the names within the Users found area. Press the 
CTRL key or Shift key to select more than one user, and then click Add 
selected users.  

8. Select a user or group, and then set permissions by selecting all check boxes 
that apply. Repeat this step for each user and group added.  

9. To save these changes, click Apply, then click OK. 
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Locking Files 

Locking a file helps prevents other users from editing or saving changes for a 
particular period of time. When you open a file that you have permission to edit, 
Xythos Drive automatically locks the file for 15 minutes. While the file is still open, 
the lock is continually refreshed. When you close the file, Xythos Drive unlocks the 
file.  

You can explicitly lock files through the Xythos Drive. This helps prevent other users 
from editing files that you are working on. Once you are done editing the file, you 
should unlock it to allow other users to edit it. An item stays locked until you release 
it or the lock expires in 7 days.  

You can not lock folders through the Xythos Drive.  

Locking a file 

To lock a file:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, and then select Lock File. To select adjacent multiple 
files, while selecting press the SHIFT key while you select the first and last 
file in the group. To select multiple files that are not adjacent, press the 
CNTL key while you select the files.  

3. In the Locking Options dialog box, set the Lock Period and click OK.  

4. No confirmation message is returned, unless the lock request failed.  

If you have configured Xythos Drive to display the status of files on the server, 
Locked is displayed in the Xythos Drive Status column.  

Unlocking a file 

To unlock a file:  
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1. Using Windows Explorer, locate the file.  

2. Right-click the file or folder and select Unlock File.  

3. No confirmation message is returned, unless the lock request failed.  
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Versioning 

Versioning is a useful way to keep track of the changes made to any file where 
versioning is turned on.  The system will automatically keep a copy of the file each 
time it is saved. If you and other users edit the same file, versioning allows you to 
revert to a previous copy if necessary, providing an automatic backup for 
overwritten files. 

When versioning is selected for a file, you are automatically given the option 
to Check Out the file. Checking out a file allows a user to edit the file and save it 
multiple times without creating a new version each time it is saved.  Checking out a 
file also creates a lock (if the file is not already locked) on a file which prevents 
other users with write permission on that file from editing it. Checking out a file 
does not, however, prevent users with read permission from seeing the changes 
made to the file while it is checked out. Users will be able to see the very latest 
version of the file whether or not the file has been checked in. 

Checking in a file creates a permanent version of the file that encompasses all 
changes made while the file was checked out. Checking in a file also removes the 
lock on the file. 

Versioning can only be set for files, not folders, through the Xythos Drive. Versioning 
can only be set for a file by a user with Administer permission for the file.  

Enabling versioning 

To enable versioning on a file:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, select Versioning, and then select Enable Versioning. 
The system will now automatically create a new version every time the file 
is saved.  

No confirmation message is returned, unless the request fails. 

Disabling versioning 

To disable versioning on a file:  

1. Using Windows Explorer, locate the file.  
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2. Right-click the file, select Versioning, and then select Disable Versioning. 
The file is no longer versioned.  

Checking a file out for editing 

When a file is versioned, you may check it out to ensure it does not get edited by 
someone else until you have checked it back in. To check a file out:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, select Versioning, and then select Check Out. The file is 
now locked. No other users can save a version of the file until you have 
checked it back in.  

Checking in a file after editing 

When you are done editing a file that you have checked out, you should check it in 
to allow other users to edit the file. To check a file in:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, select Versioning, and then select Check In. The file is 
now unlocked and a new version created.  

Undoing a check out of a file 

If you decide that you do not want to check a file out, or that you want the current 
version to remain without adding new versions, you can easily undo the check out. 
To undo a file check out:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, select Versioning, and then select Undo Check Out. The 
file is no longer checked out.  

Viewing version history 
You can view the version history of a file, as well as save prior versions to another 
location to view them. To do this:  

1. Using Windows Explorer, locate the file.  

2. Right-click the file, select Versioning, and then select List Version History.  

3. The resulting dialog displays the version history of this file.  

4. Select a prior version, and then click Save As to save the version to another 
location.  
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Personalizing the Xythos 
Drive for My WebSpace 

The Xythos Drive can be configured and fine tuned in many ways. The Personalizing 
Xythos Drive pages describe each control of the user interface. 

To Personalize the Xythos Drive, click the Xythos Drive icon in the Windows system 
tray. You will see the following tabs: 

Connect  
The Connect tab is used to define Services and connect them.  

Intellittach  
Intellittach is a simple and effective way to send email attachments as HTTP links.  

Offline  
This section describes the various settings associated with working Offline.  

Options  
The Options tab exposes several controls that let you fine tune the behavior of 
Xythos Drive.  

Backup  
The Backup tab is used to select and schedule the files you want backed up.  

Advanced  
The Advanced tab exposes additional controls for tuning the behavior of Xythos 
Drive.  

About  
The About tab gives you version information on the Xythos Drive.  
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Connecting to My 
WebSpace 

To use Xythos Drive to access files on the server, a connection between Xythos Drive 
and the server must be established. A service identifies the server you want to 
connect to, your username, and other information Xythos Drive needs to be able to 
make the connection. The Connect tab is used to define, connect and monitor 
services.  

Creating a service 

You can define up to 66 services. If you have accounts on different servers, you can 
set up a service for each server. You can also define different services for the same 
account to connect directly to different folders on the same server.  

1. On the Connect tab, click the Service arrow to display the Service menu, 
and then click New.  

2. In the Service box, type a service name. The name must be unique; if you 
choose an existing name, Xythos Drive will automatically add a number to 
make it unique.  

3. In the Server URL box, type the My WebSpace address of the account you 
are want to connect to. Since you will be connecting to a secure server, you 
must include the prefix https://. To connect to your personal My WebSpace 
account, enter the following https://mywebspace.wisc.edu/NetID, where 
NetID is your UW Madison NetID. 

4. To connect to a My WebSpace Group Directory, enter the following 
https://mywebspace.wisc.edu/groups/directoryname, where directoryname 
is the name of the Group Directory you would like to access. 

5. If you want Xythos Drive to save your user identification so you will not have 
to enter it every time you connect, in the Username box, type your 
username.  
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6. If you want Xythos Drive to save your user password so you do not have to 
type it each time you connect, in the Password box, check the Save 
password check box, and type your password.  

Your username and password identify your account on the server 
you are accessing. Xythos Drive needs this information for you to 
access your account data. If you do not have an account on the 
server, you can not connect to it. If you leave either of these 
boxes blank you will be prompted for the information when you 
connect to the service. 

Running a service (connecting to your account) 

Running a service is similar to mapping a network drive in Windows; it is a way to 
associate a local drive letter with a folder on another computer on the network, so 
that you can access files located on the server just like you access local files. 

Your administrator may have already pre-defined services for your Xythos Drive. 

To make a connection to a server: 

1. On the Connect tab, click the Service box to display the available services, 
and then choose a service.  

2. In the Drive box, choose a drive letter or use the default, and then click 
Work Online.  

3. If you see a dialog box, type your username and password, and then click 
OK.  

Ending a service (disconnecting from your account) 

You can end a service in two ways: 

To end a running service, on the Connect tab, click Disconnect  

                                        or 

In the Windows Explorer window, right-click the mapped drive, and then select 
Disconnect. 

Changing server properties 

In most cases the default server properties will be sufficient. However, depending on 
the type and configuration of the service you are adding, you may also need to make 
changes to the default property values.  

1. On the Connect tab, click the Service box to display the available services, 
and then choose a service name.  
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2. Click the Service arrow, and then click Edit to view the service properties.   

3. To the right of the Server URL box, click the (...) button.  

  

By default you will see the settings to your home directory. 

To select a folder on the server: 
  

1. On the Server URL dialog box, in the Server directory box, type the folder 
name.  

2. If you have no further changes to server properties, click OK.  

  

A computer typically has one physical connection to the network. All data destined 
for a particular computer arrives through that connection. The network port number 
identifies the data to applications on the server. The server you are connecting to 
and Xythos Drive must both agree to use the same port number. Port 80 is the 
standard port number for HTTP traffic, which is processed by a Web server. Port 443 
is the standard port number used for secure (encrypted) HTTP data, or HTTPS. Under 
some circumstances you may need to change the port number. 

To change the port number:  
  

1. On the Server URL dialog box, in the Port box, type a port number.  

2. If you have no further changes to server properties, click OK.  

  

To make a secure connection:  
  

1. To connect to the server using secure communication, select the Use secure 
connection check box.  

2. If you have no further changes to server properties, click OK.  

Changing advanced service properties 

Depending on the type and configuration of the service you are adding, you may also 
need to define the service's advanced properties. 

1. On the Connect tab, click the Service box to display the available services, 
and then choose a service name.  

2. Click the Service arrow, and then click Edit to view the service properties.   
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3. To view and change other service properties click Advanced.  

4. Select the advanced properties you need.  

  

Do not 
adjust 
server 
time to 
local 
time 

Xythos Drive displays the date and time using the settings of the 
machine where the Xythos Drive is installed. If you want to display 
date and time based upon the server, select this option.  

   
Bypass 
proxy 
server 
for this 
Service 

Xythos Drive can use a proxy server to connect to a service. Proxy 
settings are configured on the Advanced tab. If you do not need to 
use a proxy server to connect to a Service, select this option.  

   
Startup 
mode 

This option is used to select the state of the service when Xythos 
Drive is started. 
 
Online - connect to the server  
Offline - work offline with files selected as always available offline  
Disconnected - do not attempt to connect this service or to work 
offline 

   
Sharing 
Level 

  Initial Folder 
Listing 

Refresh 
Time 

Auto 
locks 

Check Before 
Open 

None From cache 60 min Never No 

Light From cache 15 min Yes Yes 

Medium From server 5 min Yes Yes 

Heavy From server 1 min Yes Yes 
 
 
Initial Folder Listing: If Sharing Levels is None or Light, when you 
connect to the service the folder list is retrieved from the Xythos 
Drive cache so that you can immediately start browsing folders. If 
you haven't connected recently, the folder listing may be 
temporarily incorrect while Xythos Drive refreshes it. If Sharing 
Level is Medium or Heavy, when you connect to the service the 
folder list is retrieved from the server first before displaying it. This 
ensures that the folder list is accurate, but you must wait for the 
refresh to complete before you can start browsing.  
   

Refresh Time: Windows makes lots of requests for folder listings. If 
all folder listing requests are sent to server, response time will be 
poor. Instead, the folder listings are cached. When Windows 
requests a folder listing and the refresh time is expired, the cached 
listing displays immediately, and then a request to update the folder 
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listing is sent to the Xythos on Demand server.  
  

To manually update the folder listings from the server, on the 
Xythos Drive Options tab, select Refresh. You can also right-click 
the Xythos Drive icon in the system tray, and then select Refresh.  
  

Auto Locks: If the sharing level is None, the files are never 
automatically locked. If multiple users edit the file, one user can 
overwrite the changes another user makes. To prevent this, one of 
the users should explicitly lock the file until changes are complete.   
  

For the other sharing levels, files are automatically locked when 
opened, and unlocked a few seconds after being closed. (For some 
programs like Notepad and WordPad, the file is unlocked as soon as 
the program that opened it closes.)  
  

Check before open: When this option is active, before a file is 
opened, Xythos Drive will check to see if a newer version exists, 
ensuring that even if the folder listings is cached, any open file 
request will get the most current copy of the file.  
  

Recommendations: Xythos recommends running at Medium 
(default) or Heavy sharing level for most users. Running at these 
levels ensures that users are always working with the latest copy of 
documents. For environments where there is virtually no 
collaboration between users, then None and Light may be used.  
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Intellitach 

Email is one of the easiest and most commonly used vehicles for sharing files and 
folders. When Intellittach is enabled, Xythos Drive can replace file attachments with 
encrypted links to files. You can use this technology to send local as well as server-
resident files. Only one copy of a file is saved on the server, regardless of the 
number of recipients.  
 
If you use of Lotus Notes or Microsoft Outlook and Intellittach is enabled, the next 
time you send a message with an attachment, you will see an Intellittach dialog box. 
Intellittach is the Xythos technology that transparently replaces the file with a link. 
Click OK and start sending links. That is the only change you will see.  
 
You attach files to email messages in the usual manner. Xythos Drive adds a link to 
the file instead of attaching the actual file. You can also right-click the file using 
Windows Explorer and select Create Intellittach. Use the Intellittach dialog box to 
confirm whether you want to send the file as link, or a ticket. You can also send a 
regular attachment in email, by selecting attach in your email client, selecting the 
file to attach and then selecting regular attachment on the Intellitach screen. 

 
Links 

A link is used when you send a file to other Xythos users. You decide who has access 
to the file via the link, and whether each recipient can read, write, or delete it, on 
an individual basis.  
 
Tickets 

Tickets are links that allow users with or without UW Madison NetIDs to access your 
files. You can grant read or write permissions with tickets. The permissions to be 
defined once for everyone that uses the ticket, rather than setting permissions per 
user.   
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When you send a local file using a link or a ticket, the file is automatically copied to 
a folder on the server. You must select the attachment folder before using links and 
tickets. Only one copy of a file is saved in the attachment folder, regardless of the 
number of recipients. 
 
Note: Intellittach only works when connecting to My WebSpace using either 
Microsoft Outlook or Lotus Notes to send email messages. If you use another email 
program, you can right-click a file or folder name, select Copy URL to Clipboard, 
and paste it into the email message. 

  

Before you can use Intellittach you must enable the feature, and identify the folder 
in My WebSpace the Xythos Drive will use to save copies of attachments.  

Enabling and Disabling Intellittach  

On the Intellittach tab, select Enable Intellittach in Outlook and Notes. To disable 
Intellittach and send file as normal attachments, clear this check box. This setting 
takes effect immediately.  

Selecting Attachment Folder 

When you use Intellittach to send a file attachment, Xythos Drive automatically 
copies the file to the server. Before sending links and tickets instead of attachments, 
you must select the server folder for Xythos Drive to save copies of the attachments.  

1. In the Use this Service when a file needs to be uploaded, choose the 
service. If you have access to an Intellittach capable service and it is not 
showing in this list, connect to the service first.  

2. In the and save the file in this directory box, select the folder you want 
attachments copied to. To help you locate the folder, click Browse.  

3. Select a folder, and then click OK.  

These settings take effect immediately. Only one service is active at any given time. 
When you change this setting, the previous service will not be used. If the service 
containing the attachments folder is not connected, when you send a file while 
Intellittach is enabled, the service will be automatically connected. 

Changing default sending options 

If Intellittach is enabled, when you send an email message with an attachment from 
Microsoft Outlook or Lotus Notes, the Intellittach dialog box is displayed to allow you 
to change the default sending options. 
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If you do not want the Intellittach dialog box to automatically appear, on the 
Intellittach tab, select Do not display Sending Options when sending email.  If you 
need to change the default sending options, you can manually display the 
Intellittach dialog box by pressing SHIFT when you send the email message. 
 
 If this option is not selected, when you click Send the Intellittach dialog box will be 
displayed by your email client. 

  

Sending attachments as links: 

On the Intellittach tab, under Default Sending Options, select Link.  

When you send an attachment as a link, the recipient must have Read permission on 
the file to access it. To ensure that the attachment can be read:  

Click Link Options, and then choose Change Permissions. 

The Sharing Options dialog box will be displayed whenever you send attachments as 
links, giving you the opportunity to change file permissions at that time.  

  

Sending attachments as tickets: 

When you send an attachment as a ticket, you do not have to consider the file's 
permissions. With tickets anyone that receives the email message (either directly 
from you, or because it was forwarded by one of your recipients) can access the 
attached file, whether they have an account on the server or not. 
 
To send attachments as tickets:  

 On the Intellittach tab, under Default Sending Options, select Ticket.    

You can decide whether your recipient has write permission or not.  

Press Ticket Options to select Read and Write or Read Only permissions for the 
recipients.  

Tickets expire after a certain period of time. Once a ticket expires, your recipients 
can no longer access the attachment. The default lifetime is 30 days. You can 
change the lifetime in the Ticket Options box. 
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In summary, sending attachments as links is more secure.  You can identify specific 
users and grant them individual permissions. When you send tickets, you don't have 
to consider permissions, but anyone receiving it can access it.  
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Offline 
To ensure the files and folders you need are available when you are offline, you 
need to identify them to Xythos Drive cache. You can choose to have Xythos Drive 
synchronize these files when you connect to and/or disconnect from the server.   

Xythos takes care of keeping files selected to be available offline synchronized 
between your local PC and your account. By default, synchronization will occur when 
you connect and when you disconnect.  

Use the features available on this tab to select the files you want to use offline, to 
synchronize your offline files with the files on the server, and to select when you 
want synchronizations to occur.  

Synchronization Options 

  
On connection If selected, when you connect online Xythos Drive 

synchronizes the local copies of offline files with the 
corresponding files on the server. By default, this 
option is selected. 

  
On disconnection If selected, when you disconnect Xythos Drive 

synchronizes the local copies of offline files with the 
corresponding files on the server. To end a 
connection, press the Disconnect button on the 
Connect tab, or in Windows Explorer, right-click the 
mapped drive and select Disconnect. When you exit 
Xythos Drive all connected services are disconnected 
and no synchronization occurs, regardless of this 
setting. By default, this option is selected. 

Note: If neither of these settings is selected, your files will not 
be synchronized. 

Synchronize Now Click this button to immediately synchronize the 
local copies files selected as always available offline 
with the corresponding files on the server. Please 
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note that the server files will overwrite the local files 
using this option. 
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Options 

There are several options available for customizing Xythos Drive. The 
optional parameters apply across all Xythos Drive services. You may 
edit these settings on the Options tab. 

Status Monitor Settings 

When Xythos Drive begins transferring a file, or requesting data from a 
server, a message appears in the Status Monitor. For file transfers or 
other requests that take over three seconds, the Status Monitor is 
displayed to notify you of the activity. To control when the Status 
Monitor is displayed, go to the Options tab, under Status Monitor 
Settings, select one of the following:  

  
Show on errors only The Status Monitor appears if Xythos Drive is unable 

to connect to a service. 
  
Show when necessary The Status Monitor appears when Xythos Drive is 

waiting for a file to be uploaded or downloaded. 
  
Show always The Status Monitor appears whenever any activity on 

a service connection takes longer than 30 seconds.  

Miscellaneous Settings 

Open Explorer 
window after 
connection 

If you select this option, a Windows Explorer window 
will open whenever you manually connect to a 
service. This setting does not apply to services that 
are connected automatically when Xythos Drive 
starts. By default, this option is selected. 
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Cache Settings 

The cache is the area of your local hard disk that Xythos Drive uses to 
save copies of recently used files and folders. Keeping this information 
in the cache ensures faster access by eliminating the need to retrieve 
the file or folder from the server on subsequent usage. And, because 
these files are in the cache, they may be available offline whether they 
have been selected for offline access or not.   

  
Cache size If the cache size is too small, Xythos Drive spends 

time deleting old files to make room for newly 
accessed files. For best performance the Cache size 
should be no less than the total size of all the 
account files you regularly access. The default is 64. 

  
Clear cached files 
upon disconnect 

When this option is selected, the files from a drive 
that are in the cache are cleared when that drive is 
disconnected.  

    
Clear Cached Files When you click this button, all cached files are 

deleted, forcing the Xythos Drive to download files 
from your account the next time you access them. If 
other users edit a file this feature ensures you access 
the most recent version, possibly with other users' 
changes. However, performance will be temporarily 
reduced. 

Refresh When you click Refresh, the next time you open a 
folder Xythos Drive will obtain the folder listing from 
the server rather than from the cache, ensuring you 
are working with the most up-to-date folder 
information. 

  

ZoneAlarm Configuration 

If you are using ZoneAlarm you will need to do some additional 
configuration in order to allow Xythos Drive to properly work with this 
firewall.  

Normally, ZoneAlarm blocks low-level access to remote servers. 
Therefore, in order for Xythos Drive to access a server, you must add it 
to the list of permitted servers in ZoneAlarm.  

1. On the ZoneAlarm main window, select the Security tab.  

2. Click the Advanced button. (For ZoneAlarm Pro users, select the LocalZone 
Contents tab.  

3. Click the Add button, and select Host/Site.  
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4. Enter a description and the host name of the server you want to access with 
Xythos Drive. To access My WebSpace you would enter mywebspace.wisc.edu 
as a host name.  
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Backup 

You can set Xythos Drive to automatically backup files not permanently 
stored on the server, such as the My Documents folder. Xythos Drive's 
Backup provides a simple way to back up files on your local hard disk. 
Select the files or folders to backup, the location you want them 
backed up to, and the schedule for backing them up. The files are 
copied to the server maintaining the same folder structure and with no 
modifications or file compression, making it easy to browse or restore 
the files. After the initial backup, only files that have changed will be 
copied to the server.  

Backup Options 

  
Store files on You can store files on any Services you have defined.  
  
in the directory This box contains the name of the folder your files 

will be backed up to. If you have not selected a 
backup directory, this box contains ?\Backup. Click 
the Browse button to select a different folder or do 
not make a change and Xythos Drive will create a 
folder named Backup on the selected server. 

  
Files to be backed 
up... 

This allows you to select the files to backup. Put a 
check next to the folders or files to backup. When 
you select a folder, all files and subfolders are 
selected. Double-click folders to find and select 
individual files. 

  
Schedule Press this button to set the schedule to backup files 

automatically. Select Schedule backup, if you want 
backups to be done automatically. Then specify if 
you want them run Daily or Weekly, and the time to 
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start. If Xythos Drive is not running at the specified 
time, you will be asked if you want the backup to run 
the next time Xythos Drive is started. 

  
Backup files now Press this button to run a backup immediately.  
  

Selecting Files and Backup Location  

1. In the Store files on box, choose a server to store the backup files on by 
selecting a service.  

2. The in this directory box, indicates the folder on the server that will be 
used to backup the selected files. If you have not selected a backup 
directory, this box contains ?\Backup.  

a. Click the Browse button to select your backup folder,  

or  

b. Do not make a change and Xythos Drive will create a folder named 
Backup on the selected server.  

3. Click Files to be backed up.  

4. Click the box to the left of every folder you want to backup. When you 
select a folder, all files and subfolders are selected. Double-click folders to 
find and select individual files.  

5. Click OK when you have finished selecting files and folders.  

To Schedule Daily/Weekly File Backups 

1. On the Backup tab, click the Schedule button.  

2. Select Schedule backup.  

3. Select Daily or Weekly.  

4. If you selected Weekly, choose one or more days you want the backup to 
occur.  

5. Choose Start time.  

6. Click OK.  

To Do a One-time File Backup 

If you want to backup your files but prefer to not have this be a 
scheduled task, you can run the backup manually. This is also an easy 
way to copy a large number of files from your local hard drive to a 
server. To do this: 
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1. In the Store files on box, choose a server to store the backup files on by 
selecting a service.  

2. The in this directory box, indicates the folder on the server that will be 
used to backup the selected files. If you have not selected a backup 
directory, this box contains ?\Backup.  

a. Click the Browse button to select your backup folder,  

or  

b. Do not make a change and Xythos Drive will create a folder named 
Backup on the selected server.  

3. Click Files to be backed up.  

4. Click the box to the left of every folder you want to backup. When you 
select a folder, all files and subfolders are selected. Double-click folders to 
find and select individual files.  

5. Click OK when you have finished selecting files and folders.  

6. Click Backup files now to begin the backup.  
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   Chapter 

16 
Advanced 

The Advanced tab provides extended configurations for Xythos Drive.  

Proxy Settings 

Xythos Drive will detect and configure any necessary parameters for 
proxies or firewalls. However, you can be more explicit about these 
detections by manually configuring your proxy settings.  

When Xythos Drive is first installed, the settings will be set to Auto-
detect on connection. Once a connection has been made, it will be set 
to either Direct connection, no proxy or the actual proxy address.  
  
 To Set a Proxy Address Manually:  

1. Press the Change Proxy Settings button.  

2. Click the HTTP(S) check box until a solid checkmark appears and the Proxy 
server box is clear.  

3. In the Proxy server box, enter the proxy address. If you would like to have 
Xythos Drive run the auto-detect again, click the check box until the check 
mark appears dimmed.  

4. Click OK.  

To Set a Proxy Authentication information:  

1. Press the Change Proxy Settings button.  

2. Under HTTP Proxy Authentication, enter the Username and Password for 
your proxy server.  

3. Click OK.  
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User Settings 

  
User Identification If there are multiple user accounts on the local 

operating system, identify the current user for Xythos 
Drive to use when creating locks on files or folders. 

  
Language Xythos Drive screens can be displayed in several 

languages. To change the current language, select it 
from the Language list. The new language selection 
will be used the next time Xythos Drive is started.  

  

Logging Options 

When you report a problem the log files can help identify the cause of 
the problem. When you contact DoIT for support, you may be requested 
to forward these files. To improve support, Xythos Drive is installed 
with logging enabled. The log files are stored on your machine in your 
Documents and Settings folder, usually located at C:\Documents and 
Settings\PC user account name\Local Settings\Application 
Data\Xythos\cache\logs\. If you do not see this folder, Windows 
Explorer may need to be set to show hidden files. On the Tools menu, 
select Folder Options. On the View tab, select Show hidden files and 
folders, and then click OK. 

 Each check box controls a different area of logging.  

  
Log HTTP exchange Includes all information about communication 

between Xythos Drive and the server, except folder 
listings, in the log file. 

  
Log monitor 
messages 

Includes the messages that appear in the Status 
Monitor in the log file. 
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